RSpec Update Version 2.1.1
Dear RSpec User,
Welcome to this new version!
For videos about the new features in previous releases, use this link. There are no videos for this
release.
Visit our online forum: https://groups.io/g/RSpec-Astronomy. We have a great community there.
If you’re updating from an older version:
Our software license entitles you to free updates for 12 months after purchase.
To install this update, the Help, About screen in RSpec must be October 11, 2022, or more
recent, as shown below:

If you need to purchase an update, you can get further info at this link.
I’m always interested in getting feedback and hearing what you’re doing with the software. Please
let me know what features and changes you’d like to see in RSpec. I’d also love to hear what you
think of the new features.
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RSpec Update Version 2.1.1
•

New feature: The SharpCap Bridge now allows you to explicitly name the folder that
RSpec should monitor. This new feature is helpful if RSpec is unable to find SharpCap on
your computer.

•

New feature: RSpec has a new Dark mode for use at night. Use the RSpec > View menu to
toggle Dark Mode on and off. Dark Mode is preferred by some users, especially at night.
In addition, may also find Microsoft’s Dark mode helpful in your nighttime observing
sessions. To enable Windows dark mode, on the Windows Start Menu, navigate to
Settings > Personalization > Colors, then open the drop-down menu for "Choose your
color" and pick Dark. This setting will change the look of the Windows Start menu and
apps.

•

New feature: RSpec’s toolbar buttons are now twice as big, making them much easier to
read:

•

Translation: The German translation of RSpec has been updated. (Thanks to Erik W.!)

•

Bug fix: RSpec was not properly applying changes to the “Point Size”-field on the
Appearance screen to the Main profile.

•

Bug fix: In some circumstances, when dividing to create an instrument response curve on
the math screen, RSpec was adding an extra point at the very left (0,0) or very right of the
spectrum.
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RSpec Update Version 2.1
The notes below are a brief overview. For the most complete information,
see the online videos under “Update 18” at this link.
Version 2.1.0.26
•

In some cases, clicking on the Crop toolbar button on the left (Image File) window resulted in an
error message. This bug is fixed in this release.

Version 2.1.0.25:
•

Magnetic Mouse: when you move the mouse cursor in the graphing area, the mouse is now
magnetic. In the past, it was often a struggle to click on points and graph lines because they are so
tiny. With the Magnetic Mouse, if you click near a point or line, RSpec detects the nearby object
and assumes that you intended to click on it.
Says Tom, “I feel this is one of the more significant enhancements to the usability of RSpec that
I’ve ever implemented. The Magnetic Mouse makes it a pleasure to work with profile graphs.”

•

Appearance Screen: A new button sorts labels by wavelength or text. This feature helps you keep
your labels on the Appearance screen organized and easily found.

•

Appearance Screen: labels can now be oriented at 45°. (See the screenshot below for an
example.)

•

Appearance Screen: vertical label lines can now be dotted rather than solid. °. (See the screenshot
below for an example.)
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•

Appearance Screen: Layout files can now be opened directly so you can more easily manage
them.

•

Appearance Screen: There’s a new command to delete Layouts that you’re no longer using.

•

New Continuum tool: Create a continuum by clicking on a handful of points. This is very helpful
when creating instrument response curves or normalizing/rectifying spectra.

•

Continuum: A new method (under the “More” button on the Edit Points screen) for creating a
continuum has been added. You can now create a continuum that connects the Measure Lines.

•

You can maximize the graphing area to fill the height of the screen with a new checkbox above
the graph. This lets you see more detail in your profile in higher resolution.
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•

Presentation Manager: create a 3D view showing how your spectra evolve over time. This feature
is great for creating time-series that show short term changes in a star, as shown below.

•

Presentation Manager: a new tool lets you anchor labels on any profile so that they stay properly
positioned when you re-scale the offsets.

•

Non-linear Calibration screen: a new tool shifts your profile by one pixel to the left or right to
correct for Doppler shift or mechanical shift of your instrument.

•

The orange capture lines are restored to their previous position when you re-start RSpec.

•

Two new Element files have been added. They contain a large number of common element lines
to help you identifying features in your spectra. The Details tab on the Elements screen now has a
panel containing Notes about some Elements. For example, see the “Calibration AFGKM stars”
entry on the Elements window.
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•

Speed up: RSpec is much faster and uses less CPU resources, especially when displaying a large
number of Labels from the Appearance screen

•

Video processing was sped-up. And, some problems that RSpec had with ZWO cameras have been
fixed.

•

Bug fix: As shown below, a bug has been fixed so that commas used as decimal points no longer
fails:

•

The SharpCap Bridge: RSpec can now process SharpCap video and static images in real-time. See
the tutorial videos for more information.
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Previous Version 2.0.0.13:
This version adds no new features. It includes a more complete German translation. If you would like to
provide a translation for any other languages, please contact us.
With this minor update, RSpec now tracks bugs better, allowing you to report problems from a pop-up
window that appears when there are problems.

Previous Version 2.0.0.10
•

A new screen called the Presentation Manager allows you to display up to 20 spectra at the same
time, as shown below.
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•

The Presentation Manager enables you to stitch two side-by-side spectra. This can be helpful in
low resolution and higher resolution spectra as shown below:

•

Two new buttons in the Image File tab will directly open the Capture folder and the Options
screen for Capture monitoring:

•

When RSpec displays a list of files that you’ve previously used, it dims and disables any files no
longer exist.

8

•

Holding Shift when you click to open a list of previous used files now shows the full path to the
files:

•

You can now increase the width of the Measure Lines from the Appearance screen:
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•

The list of Greek letters that pops up when you right-click in the text fields on the Appearance
screen now includes the Greek letter Eta:

e

•

A new checkbox that appears when you click the Appearance screen’s “Copy All from…” will
vertically and horizontally align all Label text.

•

Profile files (.dat files) that are imported can now be delimited by commas as well as <tab>. This
allows you to import data from other sources that may use comma as a delimiter. Turn this option
on via the Options screen. (Note that this interferes with the proper reading of international
datasets that use a comma to delimit thousands in numbers.)

10

•

Radio buttons on the Zoom (Magnifier) screen now allows you to make the Orange selection box
lines more narrow.

•

If you remove the checkmark from the Auto-Scale Y-axis option, a new “Set Zoom” button lets you
zoom to any values. This can be useful to standardize your spectra presentations.
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RSpec Update Previous Version 1.9.0.40
The notes below are a brief overview. For the most complete information,
see the online video #36, entitled “Update 16” at this link. Some of the
features in this update may already be on your machine if you recently
downloaded the software.
•

The Elements window now has buttons to make the fonts larger (for legibility) or smaller (to see
more elements without needing to scroll), as shown below:

•

You can now zoom the profile graph to the current Measure lines. Reminder: you can also click
on the numbers to the right of the button to enter in a new position for the measure lines from
the keyboard and to save and recall their previous position:
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•

The Move-buttons on the Magnify/Zoom screen now moves the blue and green lines if they’re
visible and selected in the legend (in the upper left hand corner of the main screen.)

•

On some older (XP or Win7) or newly built machines, RSpec would report an error when loading
FITS files. This bug has been fixed. You shouldn’t be running those versions of Windows anyway.

•

In the past, RSpec occasionally had difficulty calculating non-linear 3rd or 4th order calibrations. The
statistical algorithm has been improved to eliminate this problem.
Also note that in the past, when doing non-linear calibration, RSpec automatically added a point at
0,0. RSpec no longer adds that point. If when calibrating, you get an unexpected warning that
there’s a negative slope, you should select a lower order or crop the image on the left and right
more closely to the calibration points.

•

The horizontal slider for One Point Alignment at times wasn’t long enough to accommodate high
dispersion spectra (e.g. a DSLR with a objective grating). You can now click on the minimum and
maximum numbers to change the range of the slider.
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•

The brightness of the color fill under the profile can now be solid rather than relative to the
brightness to the intensity of the graph.

You can choose which of the above fill styles you want using the checkbox shown below:
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•

The 3D Pixel Map now allows you to view a single channel (Red, Green, or Blue) a time.
Let’s first look at the Pixel Map for a typical color image. Like all image processing software, RSpec
combines the RGB color channels into a single number, the monochrome intensity value:

The above Pixel Map looks fine. All values are well below 255. There are no flat tops. So we might
conclude that there are no saturated (over-exposed) pixels. But, to convert RGB to mono, image
processing programs combine the individual Red, Green, and Blue pixels using a weighted average,
which can hide saturation.
So, now let’s look at the same image, but this time we’ll use the new radio buttons to view just
the Blue channel:

Notice the flat top on the blue end of the spectrum? It is definitely over-exposed. You will need
to reduce the exposure time.

15

You can use the new radio buttons to examine the Pixel Map for each color channel. This will
enable you to detect saturated pixels that are hidden when converted to monochrome.
As usual, this feature works on both images and video. Note that if your video frames are very
large or your frame rate quite high, the above screen can really slow RSpec down. To avoid that,
you can limit the size of the region being analyzed by selecting a sub-region: Open the pixel map
and then while holding down the Alt keyboard key and your left mount button to select a subregion in an area on the main screen’s image.
•

For many years, this button has copied a screen capture of the Profile graph to the Windows
clipboard:

You can now optionally include the Angstroms/pixel value. This value is helpful to others when you
are sharing your spectra.
To enable this, on the Options screen, there’s a new checkbox, as shown below.

When the above box has a checkmark, if you copy the profile to the clipboard (with the toolbar
button or Edit option on the top menu bar on the main screen), the Angstroms/pixel value will
appear as shown below when you paste the clipboard contents into a document, as shown here:
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•

On the Appearance screen, you can now add a label to the profile Y-axis:
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Reminder: If the Measure lines are visible (but not the Elements window): when you hover your mouse
over the profile line, the floating window will show the y-axis intensity values, as shown below. These
unitless relative intensities are the sum between the orange lines of one column in the image.
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New Features in RSpec Previous Update Version 1.9.0.17
•

RSpec’s video processing has been significantly enhanced for reliability, speed and flexibility,
especially on modern videos cameras with large video frames and fast frame rates:
•

By default, RSpec no longer adds black borders to images for rotation. Images sizes (in
pixels) are thus now smaller and faster.
Note: If you have any previously saved calibration files that you saved from the Calibration
Wizard screen, you will need to re-create them for accuracy (or use the Options, Advanced
tab to re-enable the black borders for square images.)

•

A small window beneath the video window shows the current video status:

•

A new video statistics window provides additional statistics, allows automatic cropping by
pixel counts, and enables flipping of the video image vertically and horizontally.

•
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•

The Rotate button now flashes red when a rotation is in effect. This is intended to remind
you that rotation is expensive computationally. We encourage you to carefully mount
your Star Analyser grating so that spectra don’t require rotation.

•

The two submenus under the Live Video “Configure” button now have their own
dedicated buttons labelled “1” and “2.” This makes them faster to access, as shown
below:

•

The Histogram stretch box has been sped up two or three-fold on static images and
videos. It can now be used on the entire frame even while videos are playing.

•

Videos can now be cropped in real-time. Use CTRL and hold the left mouse button to
frame in an area. Then add a checkmark to the box shown below:
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•

A new toolbar button allows you to crop to the current zoom level on the profile graph:

•

A new checkbox automatically fills in the Hydrogen beta wavelength on the Calibration
Wizard screen:
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•

There are two new ways to splice two spectra side by side. This feature is mainly for slit
spectra.
1. Load one spectrum on the Main profile and the second spectrum on the
Reference profile. Then use the Reference, Edit on 2 Series option to combine
them.
2. Use the Folder icon at the top of the profile screen to select more than one profile
(using Ctrl or Shift click), as shown below:

•

The area under the profile curve between the two Measure lines is now displayed:

•

Holding the Shift key down when clicking the Calibrate button will re-load and apply the
most recently save Calibration from the Calibration Wizard screen.

•

The Reference Library now optionally crops the spectra when they’re displayed on the
profile graph:
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•

RSpec can now save 1D FITS images. These files similar the .dat files that RSpec saves x,y
profile data. They contain the necessary information to submit them to Pro-Am
collaboration databases like the AAVSO AVSpec (link) and BeSS (link).. You will need to
contact the database owners for details on how to submit these files.

•

The Header button above the image window (on the left hand side of the RSpec screen)
will now display the header information on RAW, TIFF, JPG, BMP files. In the past it only
showed header information for FITS files.

•

When exporting a video from images (using the Tools, Create Video menu option) you can
now choose the video codec to be used.

•

A bug was fixed that in some circumstances caused wavelengths to be lost when loading a
saved layout on the Appearance screen.

•

If you drag a window to a second monitor and then close and restart RSpec, the window is
now properly shown on the 2nd monitor rather than the primary monitor.

RSpec Previous Update Version 1.8.0
•

A new feature enables very fast rotation of your spectrum image.
Hold down the ALT key and then click and hold the left mouse button on the zero order
star. Then drag (while continuing to hold down the left mouse button) through the
spectrum. When you release the mouse, the spectrum will be rotated horizontal.

•

Image cropping: Camera sensors often have lots of pixels. But your spectra actually sit in
only a small number of those pixels. By boxing-in or zooming your image, you can include
only the pixels you need. RSpec runs much faster on smaller images.
To crop your image: hold down the CTRL key and then hold down the left mouse button.
Move the cursor until you have a red box around your spectrum. Release the mouse
button and click the “Crop” button on the left-hand toolbar:
. In many cases, especially
with spectra from the large sensor of DSLRs, you’ll see dramatic a dramatic speedup of
RSpec.

•

Our beautiful Periodic Table of Spectra is now available with better shipping rates outside
the US. This poster is identical to the one that we’ve been selling for the past year, except
that the international version is not laminated.
Cost is $29.95 plus $6.95 shipping. International: link. US customers: link.
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RSpec Update Version 1.8.0.30
•

Versions 1.8.0.30, 1.8.0.29 and 1.8.0.28 were minor updates that fine-tuned the automatic
cropping of very large DSLR images and made other internal changes for better performance of
the software. Below are the enhancements for previous releases.

•

Version 1.8.0.27 was a minor release that added a live chat button to the toolbar and eliminated
some false alarms from anti-virus programs. Below are the enhancements that were in 1.8.0.26:
Video #31 (“Update 13”) on the RSpec video page (link) demonstrates the videos below:

•

In the past, the most common way to open image files (FITS, JPG, RAW, BMP, etc.) was to click
on the Open-button on the left hand screen. Now, rather than using the Open button, you can
drag and drop image files onto the left image window.

•

RSpec can now read 1D FITS spectra.
1D FITS files are similar in content to RSpec’s .dat files that are created by the floppy button on
the toolbar above to profile graph. Many on-line databases use the 1D FITS format to share
profile graphs in x,y coordinates (wavelength and flux intensity). For examples of interesting
data you can now load into RSpec, see the BeSS database (link) or the A.R.A.S Spectral Database
(link)
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•

RSpec can now display the FITS header of the most recently opened 1D FITS file.

•

A new tab on the Pixel Map displays a 3D view of your spectrum. This very useful tool allows
you to explore your spectra in a new way, examining it exposure levels, artifacts, hot pixels, and
other details.

•
We are now offering a beautiful color poster of the Periodic Table of Spectra. It’s laminated and
printed in brilliant color.
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Click this link to go to our site for more info on the poster (and spectra mugs, tee shirts and iPhone
covers.)

Tom showing Neil deGrasse Tyson our new poster.
In previous releases, RSpec sometimes encountered problems when loading extremely large
images like those that come from large format DSLRs. This problem has been eliminated. The
program now automatically crops the margins in large images so that their final size is 16
megapixels.
The Spline Smoothing slider on the Edit Points screen has been made less sensitive. It’s now easier
to drag the slider to fine tune your fit.
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RSpec Update Version 1.8.08
•

Discontinuous Background Removal: In the past, the regions that were used for subtracting
backgrounds had to be immediately adjacent to the orange capture box. This restriction could
be limiting at times. For example, the adjacent region might contain other stars or spectra that
would interfere with the background removal.
To remove this limitation, RSpec has a new checkbox that allows you to specify regions that
are disconnected from the orange region. (See screen capture below.)
To move the new capture lines, first select the region in the top, left Region window. Then use
your mouse to move the new boxes in the same way you’ve always moved the orange lines in
the past.
Note that the RSpec Options screen allows you to select whether to subtract the average or
median of the blue regions from your spectrum. Median is recommended.
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•

Real-time Correction for Instrument Response: You’ll recall that correcting for instrument
response is how you remove the effects of your camera’s reduced sensitivity in the red and
blue regions. This correction process is sometimes called “flux calibration.” Video #15 on the
RSpec site (link) discusses this process.
After you have corrected for your instrument’s response, you can compare your profile graphs
to professional graphs to determine the star’s approximate temperature and OBAFGKM type.
In the past, the process of applying an instrument response file required opening the file and
then a series of mouse clicks. In other words, it wasn’t fast or easy.
Starting with this version, RSpec can apply your instrument response calibration file in one
click. You simply specify an instrument response calibration file that you have previously
created. Reminder: you create these calibration files using the steps in the video linked-to
above. On a given hardware configuration, you only need one file, say that made from a Type
A star. With that one file, you can do instrument response correction on any star type.(Note
that all of your targets should be at a relatively high elevation to reduce reddening from
extinction.)

When you click on the new
icon on the toolbar, the window below appears. Specify your
instrument response file and then click the Apply button.
You can also check the “Correct all…” box so RSpec immediately corrects every image that it
processes. You can even correct live or recorded astronomical videos, frame by frame, in realtime. This is great for survey work because by dragging the orange capture lines, you can
quickly examine the spectral energy distribution of many stars in crowded field of view.
If you’d like to experiment with the files that were used in the tutorial videos that accompany
this release, you can download them from the bottom of this page: http://www.rspecastro.com/setupdownload. (Thanks to Torsten Hansen for the video of Albireo.)
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Enhancements to Cropping:
The Edit Points screen (shown below) now has an option to delete the points from the Reference
curve at the same time.

•

If you hold down the Shift-key as you click the Crop-button
the deletion without asking you for a confirmation.

•

If you hold down Shift-key and the Ctrl-key as you click the Crop-button
on the toolbar,
RSpec also deletes from the Reference curve without asking for a confirmation.

•

Appearance screen: Decimal digits (like 4861.33) are now allowed when locating labels, as
shown below. This is helpful if you work in nanometers or high-resolution spectra.

on the toolbar, RSpec does
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•

Two-Point Calibration Screen: When you click on the profile graph to select a pixel value for
two-point calibration, the value transferred into the field shown below is now a full floatingpoint value rather than a whole number.

•

Get Credit for Your Accomplishments: The Options screen allows you to enter your name (or
any other text you wish). RSpec will include this text on jpg and clipboard exports of the
profile graph. For example, you could use your name, or the instrument, or any other text you
wish.
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•

Saving One-Point Calibration: The Save button on the One-Point Calibration screen no longer
requires that you have previously done a two-point calibration.

•

Resizable Rotate Windows: The Rotate window is no longer fixed in height. You can grab the
top and bottom edges to make it taller from top to bottom. The taller screen makes it even
easier to drag the Rotation scroll bar to the position where you want it.

•

Higher Precision on Rotate screen: There is a checkbox on the Rotate window that allows you
to specify rotation angle in .05 degrees rather than .5 degrees. This is for users whose particular
work requires this kind of precision.

•

Remote Control: This version of RSpec has some software hooks that allow remote control of
the software by third parties. For example, the University of Western Australia used these
features in their wonderful outreach and educational work on their Spirit telescope. If you’d like
to hear more about how to remotely control RSpec, contact us for details.

•

Quickly Load Previous Linear Calibration: After you’ve saved a two point, linear calibration
using the Save button: on subsequent runs of RSpec, Shift click the Calibrate button to instantly
load and apply that previously saved calibration.

•

Histogram Screen Saves Settings Between Usage: The Histogram window now “remembers” its
settings between uses.

•

New Histogram check-box for “Entire Image”: A new checkbox on the histogram screen allows
you to apply it to the entire image rather than just between the orange lines. (See screen
capture below.) Note that checking this box may slow down the software as it processes the
entire image. As a result of optimizations in this release, RSpec histogram processing is actually
faster on FITS images processed in 32-bit format than any other formats.
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•

New Histogram spin buttons: The histogram screen now has small spin buttons that allow you
to make small changes in the track bars. (See screen capture below.) Note that when the
histogram is being used, RSpec is actually faster on 32-bits FITS images than it is on any others.

•

Default Non-Linear Calibration: The non-linear calibration screen allows you to save a
particular calibration as a default calibration. If you check the “Apply default…”-box below,
when you start RSpec at a later time, the software will apply this calibration automatically.

32

•

The Calibration Wizard’s One Point Alignment feature now has a sliding track bar that allows you
to smoothly adjust the dispersion (in Angstrom/pixel) as you look for a match between your
data and reference data. If your initial two-point calibration of a spectra doesn’t result in a
match with the Hydrogen Balmer lines, you can use this slider to “slide” the spectrum left and
right until you find a match. (Note: this feature was included in some of the more recent new
downloads of RSpec so if you’re using a very recent version of RSpec, you may have seen this
feature already.)
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•

After you’ve calibrated a profile for instrument response, you can now determine the star’s
approximate temperature by selecting the Plank curve option on the Reference Library screen,
as shown below.
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Changes in Version 1.7
There are two videos that demonstrate the new features in this version. Use the RSpec Help
menu’s “Video Library” option, or at this link to view the videos on-line. They’re named “New
Features 10” and “New Features 10b.”
•

There’s a new button on the tool bar to open a pixel map:

The pixel map shows the ADU value for each pixel (between the orange capture lines) in your
image:

Eight bit cameras (like video cameras) can have a maximum ADU value of 255. FITS images
will also display a maximum value of 255 unless you turn on 32-bit processing on the
Advanced tab of the Tools, Options screen. (32-bit processing can slow down the software and
is generally not needed except for high precision work.)
A common mistake when imaging is to underexposure your images, which results in poor
spectra because the SNR is poor. Unless other factors (like noise, tracking, etc.) prevent it, you
should increase your exposure time so that the maximum ADU of the spectrum (not the star
itself) is about 80 - 90% of your camera’s full well depth (on modern CCDs). Above that,
modern cameras lose linearity. (It’s okay to overexpose the star.)
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You can also bracket in a region between the orange lines to examine. Do this by holding
down the Ctrl key and the left mouse button and dragging a box around the region in your
image.
The Pixel Map screen’s File menu allows you to export the pixel data to Excel where you can
further analyze the pixel intensity data.
•

The software now color-fills the area under a calibrated spectrum:
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•

The number of labels available on the Appearance screen has been doubled:

•

When exporting x-y profile data to a .dat file for importing into another program, you can now
specify the starting wavelength. The screen below appears only if the profile was calibrated
using the Non-Linear calibration screen and the Options screen has a checkmark next to
“Generate linear X values…”
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Changes in Version 1.6 –
•

You can now display label text vertically, as shown below.

Use the checkbox shown below to change the orientation of the text:

•

RSpec can now calculate the Equivalent Width (EW) of any emission or absorption feature.
The videos show how to use this feature. Not familiar with EW? Wikipedia can act as your
introduction: link.
As we noted in the video walk-through: for scientifically valid data that you can share and
compare with others’, it’s important that your work flow be repeatable and congruent with
the scientific community’s consensus. Below are some important points. Questions? The
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experts in our Yahoo forum can help: link.
o

Camera flux values should be proportional to the amount of light to falling on them.
This is a requirement for any meaningful measurement of flux. Astronomical CCD
cameras are generally linear over a significant proportion of their range but become
non-linear as they approach saturation. Webcams and video cameras are typically
deliberately designed to be non-linear (gamma-corrected) so that shadow areas are
correctly exposed while preventing brighter areas being over-exposed.

o

The image should be processed correctly with dark, flat and background corrections
applied.

o

EW calculation is very sensitive to the correct determination of the continuum level
and shape in the region of the line. This is crucial. Small errors here can give large
errors in EW.

o

Thought should be given to how to decide the wavelength range over which the EW is
to be calculated. This can for example be done by estimating where the line meets the
continuum or, where repeat measurements of the same line are planned, by setting
fixed limits outside where the line is expected to fall.

•

RSpec now displays the current position (x-value) of the two Measure Lines. Click on the
numbers themselves to display a menu that allows you to save the current position, to move
the lines to a previously saved position, or to manually type in a desired position:

•

You can now flip FITS images vertically by adding a checkbox here on the Options screen:

This has no impact on calculations (except background removal). Some other astronomy
programs display images upside-down when compared to RSpec. This allows you to view
spectra in RSpec in the same orientation as these other programs.
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•

RSpec now uses the absolutely latest optimizations available for the Intel® multi-core CPUs.
On some advanced calculations, as well as video processing with a modern CPU, you’ll see
significant speedups.
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•

A new toolbar button will transfer the Main profile to the Reference profile. This makes it
easier when you want to compare your current profile with another. Load the first profile.
Click the button to move it to the Reference. Then load the second profile:

•

The Page-up and Page-down keys on your keyboard now zoom in and out respectively. This
is primarily for laptop users who don’t have a mouse with a roller wheel on top.
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Changes in Version 1.4
You can view a video walk-through of these features from the RSpec Help menu’s “Video Library”
option, or at this link on-line.
•

There is a new video at the bottom of the video list (under Help, Video Library) named “How to
use One Point Calibration.” This video has been posted on the website for some time (link).
We’ve found that the most frequent question that new users ask is “How do I calibrate my
spectra when the object I’m observing isn’t an “easy” star like Vega.” This video will answer that
question.

•

If you move the mouse over your spectrum profile graph while holding down both the CTRL key
and the SHIFT key, a new vertical marker appears. And the x-axis label is augmented with the
Angstrom value. (See below for an example.) This can be very helpful when you’re examining a
profile or comparing two profiles. The color of this line can be changed on the Appearance
screen.
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•

A new Zoom window allows you to zoom in on the spectrum image from your camera. You can
use this window to fine tune the placement of the two orange capture lines. Careful placement
of these lines can often result in higher quality profile graphs. As elsewhere in RSpec, changes
you make update the profile graph in real-time, so you can see the impact of your changes in
real-time.

In the Zoom window above, you can use your mouse wheel to zoom towards and away from the
mouse cursor. Click and drag to scroll side to side. Use the arrow buttons on the right to move the
orange lines up and down.
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•

You can now detach the pop-up Reference menu, as shown below. Once detached, you can
move the menu anywhere on the screen you wish where it will float, ready for use. As a
detached (floating) menu, it’s always open, which eliminates the need to click the Reference
button each time you want to use a command:

•

RSpec now speaks Dutch! Use the Tools, Language menu option. (Thanks to Marc T. for the
translation!)

•

A new panel on the Edit window allows you to delete all points to the left or right of a specific
wavelength. For example, you could use this command to eliminate all the points starting at the
zero-order star up to the UV:
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•

RSpec now handles negative flux values. When subtracting the background from a spectrum
image, due to random noise, it’s possible for the flux (intensity) value of some pixels to be
negative. In the past, RSpec rounded negative numbers up to zero. At first his might seem trivial.
Although it is generally a small effect, it affects the mean zero level and can give problems if
trying to normalize to the continuum or when measuring the intensity of lines.

For general day-to-day use, there is no need to enable negative flux handling. However, for
more advanced work, you can enable it on the Options screen, as shown below:
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•

The Math screen now allows you to adjust by a constant value. You can also now move the
results back to the Reference profile rather than the main Profile.
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•

The Appearance screen now has an “Erase” button and a Setup button. The Setup button allows
you to configure RSpec so that when you right-click on a wavelength on the Element Detail
screen, the next label on the Appearance screen is selected. (See the Video Library on this
update for a more lengthy discussion.)

•

A new command on the top tool bar allows you to split the frames in a video into individual bmp
image files. You can then preview the frames using the Tools menu’s “Create Video/Preview
Images” screen. This process lets you examine the profile of each frame and select the frames
that you want to include in a stacked video you create and then play with averaging.
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•

On the Non-linear Calibration screen, you can now view the Polynomial Factors used to fit the
points. The window can now be re-sized vertically, revealing more rows:

•

We’ve raised the number of decimal places RSpec optionally displays from two to four. Set this
on the Options screen, shown below. This is only for displayed values. Internal calculations are
still done in full 32-bit precision.
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•

There’s a great new command that lets you easily change the scale (height) of the Reference
profile graph. Here’s the button:

When you’re comparing two spectra for similar features, it can be difficult to spot which features exist in
both graphs:

Using the new “Scale Reference” button you can easily change the height of the purple curve above so
that features are almost overlapping. This makes spotting similarities considerably easier:
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Changes in Version 1.3.0 Build 39
A video walk-through of these new features can be viewed on-line here: link.
•

In the past, RSpec would scale down the FITS file flux intensities (the Y-axis values on the graph).
This did not distort the data, because the scaling was linear. However, on certain types of data
(with extremely high star intensities compared to a weak spectrum) this could result some of
the small changes in the profile graph not being visible. This would be evident by the profile
graph’s peaks appearing flattened or the lines “stair-stepped”.
This limitation has been removed. RSpec now optionally reads FITS file in in full 32-bit precision.
In this mode, the Y-values on the profile graph are the exact ADU flux values from your FITS file.
To enable the 32-bit mode, put a checkmark on the Options screen as shown below. This mode
may be a someone slower on very large format images. On most data, you will not see a
significant improvement in your profile. We suggest you leave this mode disabled unless you
observe some of the stair-stepping described, or need to compare different profile graphs for
absolute intensity.

Note: Rotation of digital images in some cases can cause significant degradation of data due to the
introduction in artifacts. Experienced spectroscopists recommend that if you are doing high
precision spectroscopy, you should not rely on image rotation. Instead, you should align your
spectrograph and sensor with one another so that the spectrum falls exactly horizontal across your
sensor. This eliminates the need for rotation and the possible artifacts it may generate.
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•

In the past, on slower computers, dragging the track bars at the bottom of the Histogram
window could be sluggish on very large images. You can now eliminate this sluggishness by
turning off RSpec’s “Live Update.” The software will then wait until you release the left mouse
button before updating the screen. (The Rotate screen has a similar option.)

•

In previous releases, in certain circumstances RSpec was unable to change the video resolution
on some webcams (for example the Toucam and Celestron NexImage). Starting in this release,
when you use RSpec’s “Live Camera” Configure button, RSpec will ask whether you want the
camera to be paused while you make the change. On some cameras (like those listed above)
answering “Yes” will enable RSpec to successfully change the resolution. You will need to
experiment with this option to see whether it is needed for your particular camera.

•

When Angstroms/Pixel is less than 10, RSpec now shows additional digits to the right of the
decimal place:
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•

On all of the buttons that are commonly used to open files, there is now a small arrow that
displays a list of the most recently used files. This reduces the amount of browsing necessary
when trying to open a file that you recently had open:
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•

You can now extend label lines to the top or bottom of the profile graph screen. This makes it
much easier to clearly label your profile’s features. See the Hα and Hβ lines on the right below:

•

When you copy to the clipboard a profile that contains a synthesized spectrum, RSpec no longer
omits a small square in the lower left and right corners.

•

When printing or copying to the clipboard, RSpec no longer includes the “Legend.”
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•

When copying to the clipboard, as shown below, the upper right-hand corner now displays the
program name and version number. The position of this text can be changed (or turned off
completely) on the Options screen. By leaving this display visible when posting images to
websites, you will help “spread the word” to newcomers about RSpec.
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•

The Calibrate screen’s Non-Linear tab now has an option for one-point alignment. (See screen
capture below.) This enables you to take a reference image at the beginning of an observing
session and then, as long as your hardware doesn’t change, use it and a single known feature
like the zero-order star or Balmer line, to calibrate subsequent images. For more details, see the
video library after updating, or this on-line video: link.
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•

The Rotate slider now allows angles down to ½ degree rather than the previous whole degrees.
This allows you to more precisely rotate your image so it’s exactly horizontal.

•

The Appearance screen now allows 24 labels (up from 12). Rather than selecting a label with a
pull-down box, you now use radio buttons, which are much faster and more intuitive.
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•

The contents of the “Angstroms/Pixel”-field for one-point calibration is now retained between
runs. (See screen capture below.) This eliminates having to re-type it every time.
As a reminder, the one point calibration function allows you to take a calibration image
of a known star at the beginning of an observing session. Unless you change your
equipment, you can use the “Angstroms/Pixel” dispersion and the wavelength of a
single feature to calibrate all subsequent images. For details, see the New Features
video in the Video Library (on the Help menu) or this web link at 1:35 seconds.

•

The Subtract Background command now allows you to subtract a different number of rows
above than below the spectrum. This can help you avoid subtracting a bright star:
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•

You can now free up screen real estate for a wider profile graph by hiding the Legend. Use
this checkbox on the Appearance screen, as shown below:
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•

The Element screen now lists the stars in OBAFGKM order and has a details tab that shows
the contents of specific lines for the current element.

•

You can now “drag-and-drop” or double-click to copy a specific line from the Detail-tab on
the Elements screen to the Appearance screen. (You can also copy a wavelength to the
Calibration screen.
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Changes in Version 1.2.0 Build 30
These features are demonstrated in the “New Features 7” video in the Video Library.
•

The Live Camera tab now has a checkbox (shown below) labeled “Crop.” If you put a checkmark
in this box, RSpec will discard the regions of the camera video that are above or below the
orange binning boxes. If you are using a higher resolution camera, this will dramatically reduce
the size of the files that RSpec records. Checking this box will also enable RSpec to process
much faster frame rates, since the number of video rows is reduced. (You’ll find that you’ll
probably want to have RSpec’s Rotation angle set to zero for the best use of this feature.)

•

Saving Profile Appearance: When you save and then later re-open a profile graph (as a .dat
file) RSpec now restores all of the labels, colors and other Appearance-screen items that were
visible when the file was saved. This means, for example, that if you have placed labels (like
Hydrogen-β) on the profile graph, they will re-appear. (RSpec saves the Appearance data in the
same folder as the .dat file. The filename is the same, but with a .ini extension. You can turn
this behavior off on the Options screen.)
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•

Element Library: Additional reference lines were added for OBAFGKM and other common
objects. These are visible as new rows on the Elements screen, as shown below. This data is for
informational purposes only. Not all of the lines will appear in your profiles.

Also notice the new Help-button at the bottom of the above window. Clicking this button displays a
document that explains the data and its sources.
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Changes in Version 1.2.0 Build 22 –
•

Non-linear Calibration: The Calibration Wizard now has a new tab for non-linear calibration
using more than 2 points. Please see the Video Library for details of operation. Or view it on-line
here: link.
The features below are described in the video entitled “New Features 6” which can be found in
the Video Library, or this link on-line.

•

The Frame Rate control has been improved so it’s more effective.

•

RSpec now optionally will allow the camera to continue running when you put a checkmark in
the Pause checkbox:
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•

You can now disable automatic un-zooming when opening a reference profile:

•

The Rotate window has new slant command allows slanting a portion of an image. This is
primarily used in the study of meteor or other moving spectra (including drift scans) where the
movement was not perpendicular to the dispersion.

•
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•

Full Width Maximum Height (FWMH) is now calculated using standard geometry rather than
the former Gaussian curve fit. The geometry that RSpec uses can be displayed by putting a
checkmark in the checkbox as shown below. The FWMH calculation is only updated when you
drag the Measure Lines to a new position or you click the “Re-calc” button.
The FWHM, for example, can be used as aid to focusing.
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•

The Element library (vertical lines used in calibration) has been enhanced to allow more than
one library to be displayed at a time. Also, when you hover your mouse over an element line,
RSpec now shows the name of the feature. To add additional element lines to RSpec, look in
Readme.txt found in Documents\RSpec\ElementsCustom for instructions.
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•

Precision of wavelength display: You can now change the number of decimal points that RSpec
will display when you hover your mouse over the profile graph.
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Changes in Version 1.0.0 Build 354 –
These changes are documented in a video named “New Features 5” which you can find inside of RSpec
on the Help, Video Library menu, or at this link on-line.
•

RSpec now has real-time black and white or color spectrum synthesis!

On the Options screen, you can now disable the automatic re- load at program start-up of
the image/video file that was open the last time RSpec was run.
•

You can now associate any file type (.jpg, .bmp, .FITS, .avi) with RSpec so you can load the
file into RSpec by double-clicking on it in the Windows Explorer. Associate the file with the
program RSpecOpen.exe, which can be found in the Program Files folder where you
installed RSpec.
Note: rather than associating a file-type with RSpec, you can also use RSpec’s “Create
Video/Preview Images” tool bar button to step through image files. (Turn on its “Preview
the Images” checkbox.)

•

The Setup installer no longer contains any videos. The Update installer now contains just the
most recent video. Users can download the entire video library from the web via an option
that appears when they try to play a video that isn’t on their machine. The Update installer
is now only 15 megabytes, which should be small enough for you to download quickly. If
downloading the video is still taking too long, please let us know how long it’s taking and
where you’re located. We can set up a mirror site for your continent.

•

The following changes have been made to the appearance screen:

67

•

The CPU meter by default only shows total CPU usage, making more room on the screen for
other windows:
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•

There is a new “Frames/Second” button that shows how many frames per second RSpec is
currently actually processing. This button also allows you to change the approximate frame
rate that RSpec uses to read a video file or video camera.

•

The Help menu contain a link to a new document that explains some steps you can take to
speed up RSpec real-time video on slower computers.
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Changes in Version 1.0.0 Build 336 – These changes are documented in a video named
“New Features 4”
•

A new feature named “Library” has been added. As you scroll through the Pickels’ reference
library, the library profile graphs are now displayed in real-time as a reference curve. This
makes it considerably easier to find the reference profile that most closely matches your
spectrum. This update installs a video that shows how to use this feature.

•

If you right-click on the spectrum (on the left side of the screen), you can paste a bitmap
from your clipboard. This makes it easy for you quickly view a spectrum profile that you
copy from a web page or other document.

•

A new option on the Appearance screen enables the display of the current filename at the
top of the profile graph.

•

Right-clicking on any text field on the Appearance screen allows you to easily enter Greek
letters. So, labels like this are now possible: “Hydrogen α” or “δ Scorpii”. These letters only
display properly on labels if the label’s font supports Greek symbols. The default Arial font
is fine.

•

To make organizing your reference files easier, the Pickels’ Reference Library that comes
with RSpec is now installed in its own folder: \Documents\RSpec\ReferenceLibrary. To
reduce clutter, we suggest that you put any reference files that you create into a different
folder. The \Documents\RSpec\Reference folder remains available for that use.

•

When switching tabs or opening a new file, RSpec empties the averaging stack. This
eliminates the counter-intuitive operation that occurred when changing to a new spectrum.

•

The dialog box that appears when opening a new video now remembers the folder last
used.

•

When opening .dat files, their x-axis label is now properly displayed as “Angstroms” rather
than “Pixels” if appropriate.

•

In some circumstances, it was not possible to apply a label to a profile that had been
corrected for instrument response. This bug has been fixed.
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Changes in Version 1.0.0 Build 329
•

A major new feature allows you to adjust your profiles by a response curve for your CCD
camera.

•

RSpec now contains an element library that will show reference lines for specific elements.
This makes it easy to locate common elements in a profile.

•

The Auto-Open command has been enhanced. It's faster and a bug that caused lock-ups on
certain machines has been eliminated. You can also now specify a file extension (e.g. *.fits)
of the files to be automatically opened. This is helpful because some cameras that produce
(non-image) data files in the same folder as image files.

•

When doing a one-point Calibration, you can now enter the dispersion in Angstroms/Pixel.
Once you know the dispersion of your setup, you can now easily calibrate any profile by
manually entering it as well as the wavelength of a single feature.

•

RSpec now can save profiles in .png format.

•

Both German and French have been added to the languages that are available. On personal
note, I wanted to thank all of the RSpec users who have been so helpful in reviewing
features, making suggestions, and testing upgrades. I couldn't do it without you. Tom

•

When opening a Reference Profile, RSpec now adds a second Y-axis to the graph. You can
turn this axis off with a new check box.

Changes in Version 1.0.0 Build 305
•

The "Subtract Background" command now allows you to subtract using the background
both from above and from below simultaneously.

•

The "Subtract Background" command now can use the mean (as previously) or median for
calculations. (Select this on the Tools | Options screen.) The Calibration Wizard has a new
checkbox that enables you to horizontally align a profile graph with a previous calibration.

Major Changes in Version 1.0.0 Build 285
•

To view a "New Features" video on the web that shows these changes, click on this link.
After you've installed this update, this video is also available on the Help | Video Library
menu.
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•

RSpec can now optionally show the Full Width Half Maximum (FWHM) of any profile
feature.

•

Binning of the input spectrum is now supported.

•

After a profile is calibrated, RSpec now properly displays the dispersion (in Angstroms/Pixel)
above the graph.

•

When measuring a spectral feature with the vertical measure lines, a new feature (named
"Measure Snap") can position the lines so that they best bracket the feature. In the past,
measuring a profile feature required careful tweaking of the measure lines to get the
symmetrical around the feature. With Measure snap, you can set the measure lines
accurately with one click.

•

When hovering your mouse over a profile graph, if the Measure Lines are turned on, the
"floating" window now shows the Y value as well as the Angstroms/pixels.

•

On the Help | Video Library menu, the "Previewing & Creating Videos" video now plays
properly. We encourage you to watch this video because the feature is a valuable one.

•

On the Help | Video Library menu, the link at the end of the Focusing video to Dr. Doug
West's helpful article now works. You can go to the article with this link rather than rewatching the entire video.

•

Bug fixed: on rare occasions, at program startup, the orange "capture box" lines would not
be visible.

•

Bug fixed: in some circumstances, toggling the "Show Second Axis" checkbox off would
result in the profile's x-axis values being those of the reference.

Major Changes in Version 1.0.0 Build 275
•

When selecting to play the "Previewing and Creating Videos" video, the video now starts
properly.

•

The link to Doug West's on-line article (at the end of the Focusing video) will now launch
your browser and take you to the article.

•

Browsing for the capture folder (on the Tools | Option screen) has been changed in
appearance to allow DSLR devices to be seen.
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Changes in earlier releases
•

A new option on the Tools | Option screen lets you enable color display if your video or
image are in color rather than mono. This may be slower on some machines.

•

When switching from the Live Video tab, RSpec now closes any live camera that is open.
RSpec was not releasing cameras, which prevented other applications from accessing them.

•

There is a new feature that will allow you to create a video from a series of FITS or other still
images. (See the Video Library for details.)

•

The video screen has a new "Subtract Background" checkbox that can dramatically reduce
noise from sky or camera glow. (See the Video Library for details.)

•

The Tools | Options screen has a new option where you can specify the folder which "AutoOpen" should monitor.

•

The Tools | Options screen has a new option to delete files after they are Auto-Opened.

•

The Tools | Options screen has a new option to force the RSpec window to always be on
top. This can be helpful if you're running several different program simultaneously.

•

The Setup button on the Live Video tab allows you to restrict the maximum size of a
captured file, and to specify that the name of the captured file should contain the current
time and date.

•

A new histogram screen can be opened from a tool bar button or from the View menu. This
screen allows you to view and adjust the spectrum image brightness.

•

The loading of FITS files has been sped up by a factor of ten.

•

The Help menu has a new "Online Resources" option that will take you to the RSpec website
page with resource links.

•

The Video file screen has a new "Loop" option. If this option is checked, when the end of a
video is reached, RSpec will rewind it and play it again. This is helpful if you have a short avi
file that you want to work with.

•

The right-hand profile screen has a new "Logarithmic" checkbox. This can be useful when
viewing the spectra of planetary nebula, making it a lot easier to see weak spectral lines that
are normally overpowered by the strong emission lines:
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